
www.autodesk.com/revitstructure 

REVIT® STRUCTURE  
 

 
Revit Structure 
Interoperability with AutoCAD 

 

 

Revit® Structure software is a building information 
modeling application for structural design, 
analysis, and documentation. Many structural 
engineering firms are familiar with AutoCAD® 
software and use it today for their work.  
 
This white paper introduces Revit Structure to 
those structural engineers and drafters who use 
AutoCAD - highlighting some of the main concepts 
in Revit Structure, comparing and contrasting them 
to familiar AutoCAD concepts, and explaining how 
Revit Structure and AutoCAD can be used 
together. 
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Current AutoCAD users interested in Revit Structure and building information modeling 
may begin with the AutoCAD® Revit® Structure Suite. This software bundle couples 
industry-leading AutoCAD software with state-of-the-art Revit Structure software for 
building information modeling. This combination protects a firm's investment in current 
technology and training, delivers the competitive advantage of building information 
modeling, and provides the flexibility to move to new ways of working based on existing 
workflows.  

For more information regarding AutoCAD Revit Structure Suite, please visit 
www.autodesk.com/revitstructure.  

 

Main Features of Revit Structure 
This section presents some of the most innovative features of Revit Structure - giving a 
brief explanation of the feature and then, if applicable, contrasting that feature with related 
AutoCAD functionality.  

Features highlighted are: 3D modeling environment, structural parametric components 
and families, intelligent sketching tools, working with multiple design views, working 
without a command line or layers, multiple users accessing a single project file, reading 
and writing to CAD formats (such as DWG), and producing documentation sets.  
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3D Modeling Environment 
One of the major differences between Revit Structure and AutoCAD is the use of true 
structural elements in Revit Structure rather than geometry. In Revit Structure, all 
drawings, views, schedules, and so forth, are "live views" of the underlying parametric 
building model. All these lives views - the 3D model views, the 2D drawing sheets, 
sections, and plans, the informational schedules and take-offs - are all coordinated 
because they are all a part of the same underlying project model. As a result, users can 
work in any of these views, switching between them as needed.  

 

The parametric change engine at the heart of Revit coordinates all the changes to the 
structure model and automatically updates all views and documentation - increasing the 
accuracy and quality of the design as it evolves.  

 

Structural Parametric Components  
Revit Structure is a true parametric structural modeler. The modeling engine in AutoCAD 
contains primitive objects and requires that all custom shapes be created manually. In 
contrast, the Revit Structure model already contains 3D parametric structural components  
- such as walls, columns, and beams - used for modeling and model-based details, and 
2D parametric components  that are used specifically for detailing. 

Revit Structure uses three types of parametric objects: (model) elements, (model) 
components and detail components. 

Elements 
3D model elements - such as walls, beams, braces, columns, slabs, etc. - are used for 
both structural modeling and detailing, but also include analytical properties for structural 
analysis in third-party software. Because these elements are used most often in structural 
models, they are given their own tool in the modeling toolbar: structural column, structural 

Figure 1 
 
The Revit Structure 
model, views and 
drawings always 
stay fully 
coordinated. 
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wall, beam, and so forth. These elements are visible in any view that is created in the 
model.  

Components 
Components are a subset of 3D model elements - those elements that are not as widely 
used, such as concrete pile caps or double angle connections, which can be loaded into 
each project on a demand base. Like the other elements, they are used for both structural 
modeling and detailing. These elements are also visible in any view that is created in the 

model.  

 

 

 

 

 

Detail Components 

2D detail components are similar to blocks in AutoCAD. These detail components - such 
as anchor bolts in footings, fasteners, plates, rebars, etc. - are used only in drafting views 
to complete 2D details.  

Figure 2 
 
Components are 
used for both 
structural modeling 
and detailing. 

Figure 3 
 
Detail components 
used in a typical 
detail.
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Revit Structure Parametric Components carry information about their relationships to other 
elements in the building structure - in contrast to the blocks and solids used in AutoCAD. 
For example, in Revit Structure, a column’s properties can state that it should go from 
Level 2 to Level 4. After this property is set, in Revit Structure the column retains its 
relationship to these levels no matter what changes are made to the model (such as 
changing floor heights).  

Dimensions always correspond to the condition or elements they are referencing and are 
accurate at all times. Updating a dimension automatically updates the parametric 
components and their relationships to other components. Locking a dimension allows a 
user to add a constraint to an element's geometry or to set geometric relationships 
between elements. After a dimension is locked, Revit Structure maintains this 
dimensioned relationship.  

Dimensioning and alignment locking in Revit Structure allow the designer to place building 
components in relation to others - and keep it that way throughout the design - thereby 
preserving design intent. Components may be locked together in more than one place to 
preserve wall alignments, and columns and beams placements while the model is being 
altered in other areas. Component relationships may be constrained and overridden at the 
designer’s discretion. Dimensions may be locked or editable while the parent elements 
behave accordingly. Because elements can be aligned and locked into place, many 
repetitious editing commands are eliminated, allowing for faster work and fewer errors. 

Dimensions in schedules behave the same way.  A user can change width and height 
values in the elements of the model and the existing schedules will be updated with 
revised size. The behavior is the same if the changes are made in the schedule as well. 
Coordination of dimensions and graphics is assured everywhere.  

Families vs. Blocks  
AutoCAD users are accustomed to storing symbols as blocks in individual DWG files. 
Revit Structure stores similar parametric components in family files. Family files can 
contain many styles of components allowing for easier organization and data sharing. 
These customizable families used by Revit Structure offer more placement options than 
the single insertion point used by AutoCAD blocks and xrefs.  

Revit Structure comes with many structural components built right into the product, 
including walls, beams, footings, etc. These are commonly referred to as “objects” in 
products such as AutoCAD® Architecture. The families and structural components in Revit 
Structure offer higher levels of customization and functionality. Users can modify 
alignment planes and add subcategories to their components. Another unique capability in 
Revit Structure is the ability of users to create their own intelligent parametric components, 
or quickly and easily customize the ones included within the Revit Library.  
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Alignment vs. Osnaps  
Revit Structure offers AutoCAD users new sketching tools like Temporary Dimensions and 
Alignment Guides. Alignment guides are similar to the Object Tracking feature in 
AutoCAD. Temporary line and arc extensions as well as other useful snap points relative 
to a user's current position in the model appear as aids during design. Whether a user is 
sketching new elements in the family editor or inserting components in a view, the 
appropriate dimensions and guidelines assist placement in the Revit Structure model and 
is based on the context of the modeling operation. In contrast, the osnap feature of 
AutoCAD snaps to any entity that fits the current osnap settings. 

With Revit Structure, the structural designer can quickly place walls, columns, and other 
components correctly with the option to easily modify their location later. 

Multiple Design Views  
Revit Structure makes extensive use of various views of the parametric building model.  

Revit Structure allows the structural drafters and engineers to work with components in 
any view - be it plan, elevation, section, or perspective - or from within a schedule (an 
informational view of the model so to speak).  

Each type of view may be opened at the same time, side by side, and any changes made 
in one are immediately updated in all other views. Users see the effects of a design 
change immediately ripple through the model, without worrying about manually 
coordinating that change in multiple views.  

Figure 4 
 
Revit Structure includes 
“out-of-the-box” 
parametric components, 
such as this open web 
joist family, that users 
can modify as needed. 
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The 3D building information model and its multiple design views lead to better 
communication within the structural team itself and between the structural design team, 
their client architects, and the contractors. 

 

Users can easily create their own views such as structural plan views fully associated with 
the corresponding levels. 

In a mouse click, automatic views are created from the model by just placing an elevation 
or section tag on the floor plan. As the model progresses, Revit Structure automatically 
generates standard views including elevation and section views, and users can easily 
create their own 3D camera view of the building. Users can also alter the display of the 
elements in any view by choosing "wireframe,” "hidden line,” "shaded,” or "shaded with 
edges display.”  

Figure 6 
 
3D model 
representations are 
particularly useful 
when geometry gets 
complex. 

Figure 5 
 
Changes made in any 
view are immediately 
reflected in all other 
views. 
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No Command Line or Layers  
Two instantly noticeable differences between Revit Structure and AutoCAD are the 
absence (in Revit Structure) of a command line and layers. The Revit Structure user 
interface has neither a command line or a layer control feature. All structural tools and 
components are presented on a single, easy-to-use toolbar. Structural drafters stay more 
focused on the model rather than the keyboard and command line. Layers are not needed 
to control the visibility of components. Their visibility are controlled through the Category 
Visibility feature which works on a per-view basis, comparable to the AutoCAD 
Freeze/Thaw/On/Off by viewport feature. Color and line type are also controlled by 
category.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In addition, components in Revit Structure "know" how to display themselves depending 
on the view in which they are seen. For example, framing elements only display in stick 
representation with automatic cutback in plan views, while all geometry is shown in a 3D 
isometric view. Braces display object geometry in elevation and 3D views while only 
symbol in dash lines are shown on floor plans. 

In Revit Structure, users assign a specific scale to each view that is created. Scale 
management in Revit Structure is much easier than traditional CAD systems, which use 
both paper scales and model scales. 

 

Figure 7 
 
The visibility table allows 
structural drafters to turn 
on and off some structural 
objects and annotations 
before printing. 
 



Revit Structure Interoperability with AutoCAD 

www.autodesk.com/revitstructure 8 

Single file, Multi-User projects  
AutoCAD users are accustomed to storing and retrieving project data from multiple files. In 
Revit Structure, all project data is stored in the single Revit Structure project file. This 
eliminates the need to work with external block and xref management. Revit Structure 
allows multiple users to work on the same project file and merge their changes with every 
"save,” or work on their own versions of the file and then merge changes at any point in 
the design (see white paper on Multi-user Collaboration with Revit Structure Worksharing).  

Revit Structures users navigate through 
the various views, sections, elevations, 
details, schedules, and drawing sheets 
of a structural project using the Project 
Browser. This Project Browser provides 
convenient access to all the project 
information from a single location - 
reducing the time needed to manage 
project content. The organize of the 
Project Browser’s Views and Sheets 
sections can be rearranged to match a 
desired project organization. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8 
 
Revit Structure 
users navigate 
through a project 
with the Project 
Browser. 
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Read/Write DWG  
Revit Structure provides industry-leading DWG compatibility using the RealDWG™ toolkit, 
and is interoperable with AutoCAD software. Revit Structure can import and export models 
to DXF™ and DWG formats. When exporting, Revit Structure matches its components 
and their subcategories from the current view to either industry standard or user defined 
layer names. Revit Structure can also import these formats into 2D or 3D views. 

Producing Paper Drawings  
Because drawings are the critical output of the design process, Revit Structure enables 
users to quickly produce accurate, detailed construction documents. All drawings are live 
views of the underlying parametric building model - the same model used during the 
design process. Therefore, any changes to the design are always updated in the drawing 
sheet views. Changes to elevations, sections, and callouts are immediately updated in all 
reflected views.  

Any view of the model can be added to a sheet and properly scaled. Once placed on the 
sheet, Revit Structure allows the drafter to work just as easily in a sheet view as in a 
model view to perform any last minute placements. Scale-dependent line weight and 
scale-independent annotation size allow the reuse of information in views without complex 
reformatting. This greatly reduces the overhead coordination and file management efforts. 
The display on the screen is what is output to paper - letting the user "see" the final result 
before actual plotting, thereby reducing the amount of plotting errors. Finally, the plotter 
hardware support in Revit Structure is limited only by the operating system. If there is a 
Microsoft® Windows® driver for a plotter, Revit Structure can use it.  

 
 

Using Revit Structure with AutoCAD 
 

This section gives step-by-step instructions for importing AutoCAD DWG-based material 
into Revit Structure as well as exporting views, details, or sheets from Revit Structure to 
AutoCAD. 

Step by Step: Importing DWG Details to Revit Structure 
The steps in this section show how to import/link existing DWG details to an Revit 
Structure project. Start by opening an existing Revit Structure project file, or creating a 
new project file and setting up views and sheets for the project. Then: 

1. Create new drafting views as placeholders for imported typical details. 

2. Import DXF/DWG details (typical details) created in AutoCAD. 

3. Place them on sheets. 

4. Save them to a Detail Library to reuse in another Revit Structure project.  
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Step 1: Create Drafting Views for the DWG Files 

To import or link an AutoCAD detail, the user creates and names a new drafting view in 
Revit Structure.  

 

Step 2: Import or Link the DWG Files 

After the drafting view has been created, either import or link the external file. Open the 
new drafting view, and on the File menu, click Import/Link> CAD formats. Select the 
Preserve colors and the Center- to-center options for the best performance. 

 

Import: When a file is imported, the data is embedded in the Revit Structure project. 
Import is recommended if a user plans to migrate most details from AutoCAD to Revit 
Structure and then modify those details using Revit Structure. 

Link: When a file is linked, the Revit Structure project file is smaller and the linked file can 
still be modified in AutoCAD. Revit Structure automatically gets the most current version of 
the linked file whenever the project is opened or the link is reloaded. Link should be used 
if details will still be developed and managed in AutoCAD.  

Import DWG files choices: 

 Black and White: Ignores color information in the external file and displays 
linked data as black and white vectors. 

 Preserve Colors: Preserves the layer or level color settings in the external file. 

 Invert Colors: Inverts the colors in the linked file, making them easier to see. If a 
black background is used in AutoCAD, colors may not be appropriate on a white 
background in Revit Structure. 

Figure 9 
 
Create new 
drafting views as 
placeholders for 
imported typical 
details. 

Figure 10 
 
Revit Structure 
users can control 
the importing or 
linking of CAD files 
in a variety of ways. 
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Positioning choices: (note: correct alignment is best assured by selecting Automatically 
place in the Import/Link dialog box). 

 Automatically place: Select one of these options for automatic placement: 

o Center-to-center:  Aligns the center of the linked or imported file to the 
center of the Revit Structure view. Use this option when external data is 
offset from the origin of the drawing. 

o Origin to origin:  Aligns the origin of the imported or linked file to the 
origin of the Revit Structure view. Use this option when relinking DWG 
files originally created in Revit Structure. 

o By shared coordinates:  Acquires origin for use with Revit Structure 
files. Use this option when linking multiple buildings together that need 
to maintain a relationship to each other, or when linking a number of 
building files together with a site plan. 

 Manually place: If offsets and dislocations were introduced during the process, 
or to link a detail into a drafting view, these options help position the data that is 
externally linked: 

o Cursor at origin: The linked file appears attached to the Revit Structure 
cursor at its origin. This is the typical option to manually place data. 

o Cursor at base point: The linked file appears attached to the Revit 
Structure cursor at its base point.  

o Cursor at center: The linked file appears attached to the Revit Structure 
cursor at its graphic center point. This option is helpful when handling 
widely displaced data. 

o Place at level: The linked file appears attached to the designated Revit 
Structure level. 

Figure 11 
 
Imported DWG 
detail in new Revit 
Structure drafting 
view. 
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Controlling the appearance of linked/imported data: 

The appearance of imported data is managed using the Imported Objects tab in the 
Object Styles dialog box. On the Settings menu, click Object Styles. Users can control the 
line weight, line color, line pattern, and the material for each layer or level in the linked file. 

 

Specifying line weights in linked or imported drawings:  

Users can specify line weights in imported files. On the File menu, click Import/Export 
Settings, and then click Import Line Weights DWG/DXF. This dialog box coordinates color 
mapping in linked files to Revit Structure line weights. The mapping can be saved to or 
loaded from an external text file. 

 

Users can review Revit Structure line weight settings by clicking Line Weights on the 
Settings menu. Note: Because Revit Structure line weights have different widths at 
different scales, many imported colors may map to a single line weight. 

 

Figure 12 
 
The Object Styles 
dialog box allows 
users to control 
the appearance of 
imported data. 

Figure 13 
 
The Import Line 
Weights dialog 
box coordinates 
color mapping in 
linked files to Revit 
line weights. 
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Controlling the visibility of entities in imported files: 

Users control the visibility of entities in imported files using the Visibility/Graphic 
Overrides dialog box. On the DWG/DXF/DGN Categories tab, users can specify visibility 
by layer for entire imported files or for all imports as a whole. 

 

 

Step 3: Place the Details on a Sheet 

After arranging the individual detail files in drafting views, open an existing sheet or create 
a new sheet for the details. On the View menu, click New >> Sheet. In the Select a 
Titleblock dialog box, select the desired titleblock. 

 

 

 

 

Figure 14 
 
Revit line weights 
have different 
widths at different 
scales. 

Figure 15 
 
The Visibility/Graphic 
Overrides dialog box 
allows users to control 
the visibility of entities 
in imported files. 
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After the sheet is created, place the drafting views in the same way all views are created 
in Revit Structure:  

1) Drag the desired views from the Project Browser onto the sheet or, 

2) From the toolbar, click View >> New >> Add View, then select the desired view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 16 
 
Place the newly 
imported detail on 
a new sheet and 
select a titleblock 
for the sheet. 

Figure 17 
 
Place the drafting 
view with the 
imported detail on 
the new sheet. 
Then the DWG 
detail becomes 
part of the Revit 
Structure 
documentation 
set.
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In the same way users can import individual details, users can also import a whole sheet 
of details in a DWG file directly into a Revit Structure sheet. This works well for typical 
detail sheets that do not need to reference any specific model view. 

When some details need to reference model views, it is recommended that each individual 
detail be saved as a separate drafting view instead of imported as a group on a sheet.  

 

 

 

 

 

 

 

 

 

 

 

 

 

This procedure may seem more time consuming but does enable that the imported 
AutoCAD details to be properly referenced to the project views.  

The user can then just drag and drop all the details onto the new Revit Structure sheet. 
Detail numbers and titles can be changed to stay consistent with new project views. 

Figure 18 
 
Several DWG details 
have been imported 
in separate drafting 
views and then 
placed onto a sheet. 
The project browser 
conveniently display 
the list of drafting 
views for that Sheet. 
This list can be 
expanded or 
collapsed by the 
user.  

Figure 19 
 
Import the sheet in a 
new drafting view. 
Then use the 
Explode tool to be 
able to save each 
detail in a separate 
drafting view. 
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Step 4: Save to a Detail Library or Reuse in other Revit Structure Projects 

To help structural drafters smoothly migrate from AutoCAD to Revit Structure as a 
complete documentation tool, all imported DWG details can be maintained and managed 
with Revit Structure. The key tool in this process is the ability to create a Revit Structure 
Detail Library composed of typical details, drawn from scratch entirely in Revit Structure or 
imported from AutoCAD. 

Once an AutoCAD detail has been imported into a Revit Structure drafting view, it can 
easily saved into a Detail Library file.  

 

 

 
 

 

 

 
 

Imported details can also be conveniently reused in other projects, directly from the 
project browser. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Data Export from Revit Structure to DWG 
This section offers users advice and guidance when exporting views, details, or sheets 
from Revit Structure to AutoCAD. The general process is: 

 Create the building model in Revit Structure. 

 Set up views and sheets for the project. 

 Create model-based and non model-based details. Place them on sheets. 

 Export views, details, and sheets to DWG. 

Figure 20 
 
To save typical 
details and drafting 
views from an 
existing project to a 
Library file, go to File 
> Save to Library> 
Save views. Pick the 
drafting views you 
need. 

Figure 21 
 
Typical details and 
drafting views can 
be reused in other 
projects with the 
Copy/Paste tool or 
“Save to New File” 
option. 
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When preparing to export views or sheets from Revit Structure to DWG format, users 
should consider; export methods, file naming conventions, data export options, and 
layering standards. 

 

Exporting Views or Sheets 

Users can export either views or sheets, depending on the scope of work to be done in 
AutoCAD, as well as the progress of construction documentation in Revit Structure. 

Exporting a view creates a DWG or DXF file of the currently selected Revit Structure view. 
All external data linked to the view will be embedded as a block in DWG or DXF format. 
Use this method to annotate only selected views in AutoCAD. 

Exporting an entire sheet from Revit Structure produces a set of DWG or DXF files. One 
file contains sheet information (borders, title block) with a viewport for each view. Each 
Revit Structure view becomes an individual file referenced into the sheet file and displayed 
in the appropriate viewport. All files are located in the same directory to facilitate tracking 
and management. 

Naming Conventions 
To keep file names consistent throughout the project, use the Revit default naming 
convention, as shown here: 

 Exported Views (not on sheets): 
[Project Filename]-[Revit Extension]-[View Category]-[View Identifier].[Extension] 

 Exported Views (on sheets): 
[Project Filename]-[Revit Extension]-[View Category]-[Sheet Number]-[Sheet 
Name]--[View Identifier].[Extension] 

 Exported Sheet: 
[Project Filename]-[View Category]-[Sheet Number]-[Sheet Name].[Extension] 

- Project Filename: Name of the Revit file 
- Revit Extension: Standard Revit file extension (rvt, rft, rfa), depending on the file open in 

Revit 
- View Category: Floor Plan, 3D View, Elevation, Section, Drafting View, or Drawing Sheet 
- Sheet Number: Standard sheet number  
- Sheet Name: Standard sheet name  
- View Identifier: Standard view name 
- Extension: Exported .dwg or .dxf, depending on user selection 

Data Export Options 
The following options are available in the Export dialog box: 

 Export Range: Select either the current view or a set of views/sheets. The latter 
facilitates a batch-like export of a range of views. 

 Export Layers File: The file displayed by default is the current export layer 
standard. Users can select a different export standard as desired. 

Layering Standards 
In the Export Layers dialog box, categories and subcategories of Revit Structure host 
components are mapped to a layer name and color number for use in a DWG or DXF file, 
using settings specified in special text files in the Revit Structure\Data directory.  
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By default, Revit Structure uses the last-specified export layer standard. The software 
supplies files for the AIA, BS1192, ISO 13567, and CP 83 standards. Users can select 
from these or create custom standards. Users can incorporate custom office-dependent 
layering standards into the workflow and apply them to external files. This helps to ensure 
data consistency within a multi-platform environment. 

 

 

 

Summary 
Given the prevalence of AutoCAD within the structural community, leveraging existing 
digital design information embodied in DWG files is a key ingredient to a successful 
adoption of Revit Structure as structural drafting and documentation platform.  

Building information modeling gives structural firms an integrated modeling environment 
for design, analysis and documentation. A purpose-built BIM solution such as Revit 
Structure improves a firm's productivity, accuracy and coordination in their structural 
design and documentation process.  

The interoperability between Revit Structure and AutoCAD allows firms to realize the 
benefits of building information modeling while preserving their investment in AutoCAD 
and maintaining the flexibility to deploy AutoCAD as needed on projects. Knowing how 
well the two products integrate - firms can now move confidently to structural building 
information modeling. 

Figure 22 
 
Export settings can 
be used to map 
Revit Structure 
components to a 
layer name and 
color number in a 
DWG file. 
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About Revit 
The Revit platform is Autodesk’s purpose-built solution for building information modeling. 
Applications such as Revit® Architecture, Revit Structure, and Revit® MEP built on the 
Revit platform are complete, discipline-specific building design and documentation 
systems supporting all phases of design and construction documentation. From 
conceptual studies through the most detailed construction drawings and schedules, 
applications built on Revit help provide immediate competitive advantage, better 
coordination and quality, and can contribute to higher profitability for architects and the 
rest of the building team. 

At the heart of the Revit platform is the Revit parametric change engine, which 
automatically coordinates changes made anywhere — in model views or drawing sheets, 
schedules, sections, plans… you name it. 

For more information about building information modeling please visit us at 
http://www.autodesk.com/bim. For more information about Revit and the discipline-specific 
applications built on Revit please visit us at http://www.autodesk.com/revit.  
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